FAQs

Gameshow Pro

e How can | import my old Gameshow Pro 3 gamefiles?

e Can | easily import my data into Gameshow Pro v4?

e What if | need to export my Q&A into an Excel Spread Sheet or a Word Document?

e How do | print my questions and answers to my game?

e How do | indicate which answer is the correct answer for each question in my game
show?

e How do | move questions from the Question Library or questions from one game to
another?

e Where can | edit the Gameshow Logo screens?

e How do | send my library files to someone else?

e I'm having issues registering my copy of Gameshow Prov 4. What steps may | be
missing?

e Can | use my GSPLFs, (Gameshow Pro Library Files) that | created on a Macintosh on a
Windows machine?

e What are the system requirements for Gameshow Pro v4?

How do you export a library of game(s) so they're available for Gameshow Pro PLAYER?

QuizPoint
e How can | import my Gameshow Pro 4 libraries into QuizPoint?
e Can | easily import my data into QuizPoint?
e What if | need to export my Q&A into an Excel Spread Sheet or a Word Document?
e How do | print my questions and answers?
e How do | indicate which answer is the correct answer for each question in my quiz?
e How do | move questions from the Question Library or questions from one quiz to

another?

Where can | edit the Logo and Theme Music screens?

How do | send my library files to someone else?

I'm having issues registering my copy of QuizPoint. What steps may | be missing?

I'm on a Windows Vista machine and | can't open my libraries, what am | doing wrong?
How do | upload a quiz to the LearningWare server?

AllPlay

e How do | assign an iClicker transmitter as the Leader Transmitter?
e What functionality does the Leader Transmitter have?
e How can | import my existing questions and answers into AllPlay 2?

Ring-In Buzzer Systemp

e How can | test our Wireless Slammer System to make sure it's working?
e When testing the Team 1 wireless slammer, it types the following key combination: /9a
NOT "9a.

Gameshow Pro

How can | import my old Gameshow Pro 3 gamefiles?

To import old Gameshow Pro v3 gamefiles into your Gameshow Pro v4 library, simply click on
File/Import and choose: "From Gameshow Pro 3 Gamefile" from the drop-down list. It will then ask
you to select either "Complete Game Data" or "Questions & Info Screens Only".
o Complete Game Data - Imports all the Team Names, Timers, Categories, Sounds & Logos
from the old gamefile.
o Questions & Info Screens Only - Imports the questions, answers and info screens only.

Can | easily import my data into Gameshow Pro v4?
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To import your already existing Q&A into your Gameshow Pro v4 library, you need to do 3 things:

1. Each game has a specific template designed for editing your Q&A in Excel prior to importing your
data into your library. Download the appropriate template below:

2. After downloading the template you're needing, simply edit the desired columns in Excel with
your Q&A and save the spreadsheet as a "Text (Tab Delimited) (*.txt)" file.

3. Open your Gameshow Pro v4 library and select File/Import and select: "From Tab-Return
Formatted Text File". Select the txt file you just saved and at the Import Questions window, select
which questions to import or select to Import All.

What if | need to export my Q&A into an Excel Spread Sheet or a Word Document?

To export your data from a Gameshow Pro v4 library, you have to choose what data you're needing
to export first. If you're needing the entire Question Bank, click on the Question Bank feature under

the Library column and then select: File/Export. If you're needing the data from just one game
within the library, click on the desired gamefile under the Library column on the left and then select:

File/Export.

After selecting File/Export, you have one of two choices to choose from:

How do | print my questions and answers to my game?

Printing questions can be done by clicking File/Print Questions and then by selecting one of the 3
options from the Print Questions window:

How do | indicate which answer is the correct answer for each question in my game show?

To indicate which answer is correct, simply click on the 1, 2, 3, 4, 5 or 6 answers in the question
editor. Gameshow Pro v4 will automatically know which answer is correct while playing the game.

How do | move questions from the Question Library or questions from one game to another?

Moving questions from the Question Bank into a game can be done by first clicking on the Question
Bank section under the Library column on the left. After clicking on the Question Bank, the list of
questions will appear on the right. Simply click and drag a question or multiple questions into the
desired game on the left.

Where can | edit the Gameshow Logo screens?

Editing the Gameshow Logo screens can be done under the Events section. The Pre-Game &
Post-Game tab under the section Display Game Logo. There you're able to select a predesigned
logo or select a custom logo of your own.

How do | send my library files to someone else?

Instructions for moving Gameshow Pro v4 library files from one machine to another:
o -Copy/paste the file into a shared directory.
o (NOTE: You only have to launch new library files like this once! After this, the library file will
automatically be associated with the GSP4 program.)
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I'm having issues registering my copy of Gameshow Prov 4. What steps may | be missing?

To register the Gameshow Pro 4 program, launch Gameshow Pro v4, then choose the Register
option from the Help menu (Note: you must have an Internet connection established to register
Gameshow Pro v4). Type or paste your Serial Number into the field provided:

Register Gameshow Pro 4 x|

Please enter your Serial Number into the field below. You will find your Serial
MNumber either in a printout shipped inside the front cover of the product
manual, or in an email sent at the time of purchase.

IMPORTANT NOTE: The Senal Number must be entered exactly as
indicated in order to register the software.

Serial Number; GSP4-

1] Cancel

Your computer will then attempt to connect to the Internet and cross reference the Serial Number
you have provided. If your computer should have trouble with this process, you will be directed to a
toll-free number for Technical Support. If your license of Gameshow Pro v4 has not been
registered, or you are playing with a demo version of Gameshow Pro v4, you will be prompted to
register each time you open the game. Simply click on the Register option and follow the above
instructions to register at this time. If you are playing with a demo version, you can also select the
Purchase option if you have not already done so.

If you continue to have issues with registering, please contact LearningWare Technical Support via
e-mail or call us at: 1-800-457-5661.

Can | use my GSPLFs, (Gameshow Pro Library Files) that | created on a Macintosh on a
Windows machine?

Yes! You can open GSPLFs on other operating systems as long as you have a registered copy of
the software on the other machine.

What are the system requirements for Gameshow Pro v4?

o Minimum 1000 MHz Processor

Windows: 98/2000/ME/XP and Windows 7
Macintosh: OSX ONLY

60 MB hard disk space

256 MB RAM

1024x768 monitor with 32-bit color

O 0 0 0 O

How do vou export a librarv of aame(s) so thev're available for Gameshow Pro PLAYER?
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-

Gameshow Pro 4 games may be exported as a Play Only Library to be used in the Gameshow Pro
Player. To export a game(s), select Export Play Only Library from the File menu:

G Gameshow Pro - LW_Sam

Fle Game Help
Mew Library  (CEHN)
Open Library  (CtI+0)
Open Recent >

Save Library  (Ct4+S)
Save Library As

Import
Export

Export Play Only Library

Print Questions  {Ctl4+P)

Quit Program

In the Play Only Library Options window, you have the choice of including either one game or
multiple games. Other options such as game, team, match and event settings can be set to view or
modify here.

For more detailed information on exporting libraries, visit our online Gameshow Pro 4 manual here.

QuizPoint

How can | import my Gameshow Pro 4 libraries into QuizPoint?
To import Gameshow Pro 4 libraries into QuizPoint, please follow the instructions below:

o Click on File/Import and choose: "From QuizPoint Library".

o Notice that GSP4 Library in the Files of Type in that window is automatically selected.

o Navigate to the directory where you saved your Gameshow Pro 4 libraries and click Open to
import them into QuizPoint.

Can | easily import my data into QuizPoint?
To import your already existing Q&A into your QuizPoint library, you need to do 3 things:

1. The Categories quiz has a specific template designed for editing your Q&A in Excel prior to
importing your data into your library. Download the free Categories template below: Game 1
(Categories-Style) Template

2. After downloading the template, simply enter the desired Q&A into the columns in Excel and
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save the spreadsheet as a "Text (Tab Delimited) (*.txt)" file.

3. Open QuizPoint and select File/Import and select: "From Tab-Return Formatted Text File". Select
the txt file you just saved and at the Import Questions window, select which questions to import or
select to Import All.

What if | need to export my Q&A into an Excel Spread Sheet or a Word Document?

To export your data from a QuizPoint library, you have to choose what data you're needing to
export first. If you're needing the entire Question Bank, click on the Question Bank feature under
the Library column and then select: File/Export. If you're needing the data from just one game
within the library, click on the desired gamefile under the Library column on the left and then select:
File/Export.

After selecting File/Export, you have one of two choices to choose from:

How do | print my questions and answers?

Printing questions can be done by clicking File/Print Questions and then by selecting one of the 3
options from the Print Questions window:

How do | indicate which answer is the correct answer for each question in my quiz?

To indicate which answer is correct, simply click on the 1, 2, 3, 4, 5 or 6 answers in the question
editor. QuizPoint will automatically know which answer is correct while playing the game:

QUESTION | | INTRO[ ] Display HINT[] Display INFO Display

‘ '¥ Layout (

Which regular cast member from

M*A*S*H* was the only one to '

actually serve in the Army in Korea?

Question

1Alan Alda

ie Farr
5l|Loretta Switt
Bob Crane

| PROPERTIES

How do | move questions from the Question Library or questions from one quiz to another?
Moving questions from the Question Bank into a game can be done by first clicking on the Question
Bank section under the Library column on the left. After clicking on the Question Bank, the list of
questions will appear on the right. Simply click and drag a question or multiple questions into the
desired game on the left.
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Where can | edit the Logo and Theme Music screens?

Editing the Logo screens can be done under the Quiz Options tab. There you can select a pre-
designed logo or select a custom and import your own logo.

How do | send my library files to someone else?

1. Locate the library file(s). (Extension will be: ".QPTLF")
2. Choose from the following options to transfer the file onto the other machine:

o O

= Burn the file onto CD.
= Copy/paste the file into a shared directory.
= Copy/paste file onto a thumb drive.

= E-mail file to other PC.
3. Once the file(s) have been transferred over to the 2nd machine, simply open QuizPoint;
navigate to the folder you saved the library to and double

o click on Library Opener.qpl
(NOTE: For more detailed information on zipping libraries, please e-mail our support team at:

support@learningware.com)

o

I'm having issues registering my copy of QuizPoint. What steps may | be missing?

To register the QuizPoint program, choose the Register option from the Help menu (Note: you must
have an Internet connection established to register QuizPoint). Type or paste your Serial Number
into the field provided:

Register QuizPoint

Please enter your Serial Number into the field below. YYou will find your Serial
MNumber either in a printout shipped inside the front cover of the product
manual, or in an email sent at the time of purchase.

IMPORTANT NOTE: The Serial Number must be entered exactly as
indicated in order to register the software.

Serial Number: QPTI-

| Cancel

Your computer will then attempt to connect to the Internet and cross reference the Serial Number
you have provided. If your computer should have trouble with this process, you will be directed to a
toll-free number for Technical Support. If your license of QuizPoint has not been registered, or you
are playing with a demo version of QuizPoint, you will be prompted to register each time you open
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the game. Simply click on the Register option and follow the above instructions to register at this
time. If you are playing with a demo version, you can also select the Purchase option if you have
not already done so.

If you continue to have issues with registering, please contact LearningWare Technical Support via
e-mail or call us at: 1-800-457-5661.

I'm on a Windows Vista machine and | can't open my libraries, what am | doing wrong?

If you explore your QuizPoint library folder, you'll notice the following: (1) Data -- Do Not Disturb
folder (2) Library Opener.qpl. (3) Desktop.ini. If you can't see the Desktop.ini file, you may have
to turn on hidden files in your tools option window. Simply delete the Desktop.ini file from within
your library folder. Finally, launch QuizPoint and you should be able to open your library by
selecting the Library Opener.qgpl file.

How do | upload a quiz to the LearningWare server?

o Select the Upload Quizzes icon in the upper right corner or your screen.

o Type your e-mail address and password you provided LearningWare on the QuizPoint
download form located on this page.

o Under the Upload Quizzes tab, click the Upload button for each quiz.

o When the upload process is finished, click Preview to view the quiz as a user or click Share
to e-mail the link to your trainers.

If you need additional help with QuizPoint, please click here to view our online manual or contact
LearningWare Technical Support via e-mail or call us at: 1-800-457-5661, ext. 241.

AllPlay

How do | assign an iClicker transmitter as the Leader Transmitter?

Setting the Leader transmitter can be done under the Team & Transmitters tab. Click the Locate
button and press A,B,C,D or E on the transmitter to register it as the Host Transmitter. A unique 1D
which is located on the back of each transmitter will show in the Leader Transmitter ID window.
This will now allow you to use that specific transmitter as the Leader Transmitter during the game.

What functionality does the Leader Transmitter have?

The iClicker Leader Transmitter allows the instructor to facilitate the game remotely from a range of
200 feet. Each button on the Leader Transmitter will do the following command during gameplay:
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How can | import my existing questions and answers into AllPlay 2?

AlIPlay will import your already typed questions and answers into a new game file if you have your
questions, answers and info in a specific tab-return formatted table.

Click below and select: "File/Save As" to download a game template to begin entering your
questions and answers in an Excel Spread Sheet.

AllPlay - Sample Template

IMPORTANT: After saving your work in your (.xls) document, save it as a text (.txt) file before
importing your questions and answers into AllPlay. Then, open AllPlay and click on "Create New
Game". Click on "File/Import Questions" and select"Tab-Return Formatted Database Table".
Navigate to your (.txt) file and click "Open”.

Ring-In Buzzer Systemp

How can | test our Wireless Slammer System to make sure it's working?

TESTING BUZZERS BEFORE GAME-PLAY: 1. Plug-in the receiver and wait to see the red light
indicating that the system is now receiving power. 2. Check each slammers' 9-volt battery to make
sure they are placed in the battery compartment properly and when pressed, the red LED light
activates. 3. Open a new Microsoft™ Word document and press down on each wireless slammer.
Each slammer will send a specific key combination. For example Team 1 will send "9a. TESTING
BUZZERS DURING GAME-PLAY: 1. Select to use the Wireless Slammer System under the Game
Options tab. 2. When a game is first lauched, you will see a Wireless Slammer System Indicator
window. Press any slammer to indicate to Gameshow Pro that you are using a Wireless System. 3.
Anytime during the game, you have the ability to roll your mouse in the upper-left corner of your
screen to a activate the Navigator window. 3. Click on "Ring-In/Test Buzzers". 4. Here you can test
each slammer to make sure they're working.

When testing the Team 1 wireless slammer, it types the following key combination: /9a NOT
“9a.

If your machine is set to any other language other than English (United States), your
slammers will not work with Gameshow Pro 4. Please follow the steps below to set your
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language settings so your slammers will work:

1. Open the Regional and Language Options in the Control Panel.

2. Under the Advanced tab, set the Language to English (United States).

3. Clicking OK will prompt you to reboot your machine.

4. After rebooting your machine, test the Team 1 slammer to make sure it sends this key
combination: "9a.

http://www.leamingware.com/support/LW_FAQ.html -9- ©2011 LeamingWare, Inc.



